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Seznam zkratek a pojmii uvedenych v dokumentu

Pojem/zkratka

Text

E166/iszrAutentizaceAis

eGON sluzba pro ovéreni pristupujiciho AlS k systému zakladnich registrd

eGON sluzby

Sluzby poskytované pres vnéjsi rozhrani ISZR a evidované v katalogu eGON
sluzeb. Informace uvedené v Katalogu eGON sluzeb jsou urcené
implementatordm (programatortim) AlIS pro jejich pfipravu ke komunikaci
se zakladnimi registry. Vice informaci na http://www.szrcr.cz/vyvojari.

Znackovaci jazyk geografie (GML), ktery stanovi gramatiku rozsifitelného

GML znackovaciho jazyka (XML) napsanou ve Schématu XML pro popis
aplikacnich schémat geografické informace.

ID Unikatni identifikdtor prvku nebo operace.
Informacni systém tzemni identifikace

1sUI Editacni agendovy systém, jehoZ prostfednictvim jsou zapisovana data do
RUIAN.
Informacni systém zakladnich registri
Informacni systém verejné spravy poskytujici prostfednictvim eGON

ISZR sluZeb referenéni Udaje ze zakladnich registrll a vybrané nereferencéni
Udaje ze spolupublikujicich agendovych informacénich systému s vazbou na
referenc¢ni udaje.

keystore UloZisté certifikat( pro Javu
Organ vefejné moci

OVM Statni organ, Uzemni samosprdvni celek a fyzickd nebo prdvnicka osoba,
které byla svérena plsobnost v oblasti verejné spravy, v souladu s definici
podle zakona o zakladnich registrech.

request Zadost ve formatu XML zasland na rozhrani webové sluzby.
Registr uzemni identifikace, adres a nemovitosti

RUIAN Jeden ze Ctyr zakladnich registri vefejné spravy, ktery obsahuje udaje o
uzemnich prvcich, tzemné evidencnich jednotkach a adresy.

SoapUl Volné dostupna (open source) aplikace pro testovani webovych sluzeb

truststore Ulozisté certifikdtd certifikacnich autorit pro Javu

validace Proces porovnani zadosti XML oproti definici webové sluzby (WSDL, XSD)

WS Webové sluzby

WSDL Web Service Description Language — popisuje rozhrani webové sluzby

XML eXtensible Markup Language

XSD Definice struktury XML (XML Schema Definition)
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1. Certifikaty pro pristup k ISZR

Editacni i informacni sluzby na vnéjSim rozhrani ISZR jsou dostupné pouze s certifikditem (pro
testovaci nebo produkéni prostredi), ktery vystavi na Zadost SZR. Certifikat je tedy nezbytny pro
uspésnou autentifikaci a autorizaci OVM. Na zakladé Zadosti dostanete sdéleni o vydani certifikatu a
certifikat, ktery je zabezpeceny heslem.

Ovéreni pfistupujiciho OVM probihad pfes eGON sluzbu E166/iszrAutentizaceAis, jejiz specifikaci lze
ziskat ve volné dostupném katalogu sluzeb.

Certifikdty pro pristup na rozhrani ISZR jsou k dispozici pro testovaci nebo produkéni prostfedi ISZR,
ke stazeni jsou dostupné na webové strance SZR: RAZR - Registracni autorita zdkladnich registr(.

Stahneme Platné certifikaty CA (soubor certifikaty.zip), tento soubor obsahuje certifikaty do
produkéniho i testovaciho prostredi ISZR.

Slozka obsahuje certifikaty do produkéniho prostredi:

a ISZR AIS CA(1).crt
s ROOT CA 5ZR.cer

A certifikaty do testovaciho prostredi:

s Test RootCA.cer
s Test SubCA1(1).crt

V pfipadé, Ze chcete pfistupovat na testovaci prostfedi ISZR, je potfeba pfistupovat s certifikatem
OVM vytvorenym pro testovaci prostredi. Analogicky toto plati i pro produkéni prostredi.

V dalSich krocich se budeme vénovat importu certifikatl a zprovoznéni na testovacim prostredi ISZR.

Certifikaty jsou nezbytné z hlediska bezpecnosti. Postup se provadi jako nezbytna pfiprava pro praci
s certifikaty v prostfedi softwaru SoapUl, ze stejného dlvodu je také potreba vytvofit zavérecny
keystore a truststore, které SoapUl pouZiva pfi praci s certifikdty. Je potfeba stdhnout korenové
soubory certifikacni autority, ktera certifikaty vytvofila. Timto postupem ziskdme certifikat véetné
certifikacnich autorit (CA).
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2. Instalace pro zprovoznéni sluZeb na testovacim ISZR

2.1 Instalace certifikatii v prohliZec¢i Microsoft Edge

Instalaci certifikat( provedeme napf¥. v prohlizec¢i Microsoft Edge (ME) nebo v jiném nastroji, ktery
podporuje praci s certifikaty a jejich nacteni.

2.1.1 Instalace certifikati ISZR
Pri instalaci certifikatl zacneme instalaci certifikatl pro testovaci prostredi ISZR.

Certifikaty Ize nainstalovat dvojim zplsobem: Pfimym dvojklikem na soubor — rovnou se spusti
Pruvodce importem certifikatu nebo v nastaveni prohlize¢e ME.

Postupné nainstalujeme oba certifikaty pro testovaci ISZR:

a Test RootCA.cer wl Certifikat X

# Test SubCAT(T).crt Obemé  podrobnosti  Cesta k certifikétu

[} Informace o certifikatu

Tento certifikat nelze ovéfit u divéryhodné
certifikacni autority.

Vystaveno pro: Informacni system zakladnich registru SubCA1

Vystavitel: Informacni system zakladnich registru RootCA

Platnost od 03.02.2014 do 03.02. 2024

Nainstalovat certifikat... ProhlaZeni vystavitele
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Instalace v ME = Nastaveni - Ochrana osobnich udaju a sluzby = Spravovat certifikdty.

Zvolime moznost Spravovat certifikdty

Ochrana osobnich udaju

Vyberte nastaveni ochrany osobnich Gdaja pro Microsoft Edge. Dalsi informace o tomto nastaveni

Posilat Zadosti Do Not Track (Nesledovat) [ ]
Povolit weblim kontrolu, jestli mate uloZené n&jaké zplisoby platby o
I Spravovat certifikaty [ I

Spravovat certifikdty a nastaveni protokolu HTTPS/SSL

V okné Certifikaty stiskneme tlacitko Importovat

Certifikaty 4
Zamysleny Gcel: <Vie> ]

Osobni  Ostatni uZivatelé Zprostfedkujici certifikaéni autority DGvéryhodné koFenové cel 4 | *

Vystaveno pro Vystavitel Datum ukonéeni platnosti Papisn

Importovat... | Exporfovat... Odebrat

Zamyélené icely certifikatu

Zobrazit

Zawrit
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Vyhleddme uloZeny certifikat, ktery chceme importovat:

[&=  £# Privodce importem certifikatu

Importovat soubor
Zadejte soubor, ktery chcete importovat.

Nazev souboru:
D:\certifikaty'\Certifikaty\ROOT CA SZR.cer Prochdazet...

Poznamka: V jednom souboru je mozné uloZit vice neZ jeden certifikdt v nasledujicich
formatech:

Format Personal Information Exchange - PKCS & 12 (PFX, P12)
Certifikdty standardu Cryptographic Message Syntax Standard - PKCS £. 7 (F78B)

Serializované dloZi&té certifikatl (S5T)

Dalsi Zrusit

V pravodci importem certifikatu zvolime vybér automatického uloZisté na zakladé typu certifikatu:

x

& L+ Privodce importem certifikatu

UloZiété certifikitd
Ulo#igte certifikatd jsou oblasti systému, kde jsou uloZeny certifikaty.

Systém Windows mdZe automaticky vybrat Glozisté certifikatd, nebo miZete zadat
umisténi certifikitu,

(®) Automaticky vybrat loFists certifikatt na zaklad® typu certifikatu

() véechny certifikaty umistit v nasledujicim GloZigt

Prochazet
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ah Certifikat X
€ &* Privodce importem certifikitu

Obeé  Podrobnosti  Cesta k certifikétu

Dokonceni Privodce importem certifikatu 3 Informace o certifikatu
Certifikat koFenové autority neni divéryhodny. Ma-li
by Zova divéryhodny, nainstalujte tent:
Certifikat bude naimportovén po Kiknuti na tiaditko Dokondit. crﬁk?::oﬁ;{%té;ivémwnw: koF:]n:v;;'l °
certifikacnich autorit.

Zadali jste nasledujid nastaveni:
Vybrané CloZiste certifikdtd Automaticky uréeno priivodcem

Obsah Certifikét
Vystaveno pro: Informacni system zakladnich registru RootCA
Vystavitel: Informacni system zakladnich registru RootCA
Platnost od 30.09.2011 do 30.09.2031
= >
Privodce importem certifikatu bt

0 Import probéhl Gspéiné.

Instalaci provedeme stejnym zplisobem pro oba testovaci certifikaty ISZR.
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2.1.2 Instalace certifikatu OVM

Dale nainstalujeme vlastni certifikat, tedy certifikdt vydany SZR pro konkrétni OVM (v nasem pfipadé
soubor ISUI-test-202011.pfx) a to také dvojklikem na soubor. Zadost o certifikdt na testovacim i
produkénim prostfedi je potfeba zaslat pres Registracni autoritu zakladnich registri (RAZR),
podrobnéjsi informace jsou uvedené na adrese: https://razr.egon.gov.cz/.

X X
£* Privodce importem certifikatu & &# Privodce importem certifikitu

Vita vas Privodce importem certifikatu. Rl s~

Zadejte soubor, ktery cheete importovat.
Priivodce vam pomdze kopirovat certifikaty, seznamy divéryhodnych certifikatd a
seznamy odvolanych certifikatd z disku do GloZi3tE certifikatd. Nazev souboru:

| D \certifikaty ISUT\ISUI-test-202011SUI -test-202011.pfx Prochézet...
Certifikét vydany certifikadni autoritou potvrzuje vasi totoZnost a obsahuje informace
nezbytné k ochrané dat nebo k vytvofeni zabezpedenych sitowych pfipojeni, Ulozisté Poznamka: V jednom souboru je mozné ulofit vice nes jeden certifikat v nasledujicich
certifikatd je systémova oblast, v niZ jsou certifikdty uloZeny. formatech:

Formét Personal Information Exchange - PKCS €. 12 (PFX, P12)

Umisténi GloZisté

(;)5 =i ulozist= Certifikdty standardu Cryptographic Message Syntax Standard - PKCS €. 7 (P78)
Aktudini uZivatel

Serializované Gloziste certifikatd (SST)
(O Mistni poditaé

Pokracujte Kiknutim na Haditko Dalsi.

II Zrtit I I Znutit

V privodci nechavame prednastavené hodnoty kromé tohoto dialogu, kde musime zaskrtnout jednu

volbu (aby kli¢ byl exportovatelny) a zadat heslo k certifikatu, které jsme od SZR dostali spolu s
certifikatem.

€ &* Privodce importem certifikatu

Ochrana privatniho klice
Z diivodu zaji$téni zabezpedeni byl privatni Ki€ chranén heslem,

Zadejte heslo k privatnimu Kidi.

Heslo:

LAl L L]

[[] Zobrazit heslo

MoZnosti importu:

[[]Povolit sinou ochranu privatniha kice (pokud zvolite tuto moznost, budete vidy
pii pouditi privatniho kiice aplikad vyzvani k potvrzeni akce)

E| Oznadt tento ki€ jako exportovatelny (pozdéji bude moiné ki€ zalohovat &
prenést)

Zahrnout viedchny roziifené viastnosti
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Zvolime ulozisté certifikatu

€ & Privodce importem certifikétu

Ulozisté certifikati
Uloziste certifikitd jsou oblasti systému, kde jsou uloZeny certifikaty.

Systém Windows miZe automaticky vybrat GloZigté certifikétd, nebo mizZete zadat
umisténi certifikitu.

| @

() Viechny certifikaty umistit v nésledujicim GloZist

Zrudit

'

£* Privodce importem certifikatu

Dokoncéeni Privodce importem certifikatu

Certifikat bude naimportovén po kiknuti na tladitko Dokondit.

| Automaticky uréeno privodcem
Obsah PFX
D:\certifkaty \ISUT\ISUI-test-2020 11\ISUI-test-202011.pfx

Nazev souboru

Znusit

Privodce importem certifikatu X

o Import probéhl dspéiné,

Pro ovéreni spravnosti instalace certifikdtu Ize zobrazit tuto stranku z testovaciho prostiedi:

https://isuiref.cuzk.cz:8445/isui_ws/IsuiNavrhZmenyObec?wsdlI.

Pokud se stranka zobrazi dobfe, byl certifikdt spravné nainstalovan.
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2.2 Export vytvoireného klice z ME
Nastaveni - Ochrana osobnich udaju a sluzby = Spravovat certifikadty.

Ochrana osobnich udaju

Vyberte nastaveni ochrany osobnich Gdaja pro Microsoft Edge. Dalsi informace o tomto nastaveni

Posilat Zadosti Do Not Track (Nesledovat) [ ]
Povolit weblim kontrolu, jestli mate uloZené né&jaké zplisoby platby o
ISpravovat certifikaty (&4 I

Spravovat certifikdty a nastaveni protokolu HTTPS/SSL

Zde vybereme pfislusny certifikat a dame Exportovat:

Certifikaty X
Zamysleny acel: <W&e> e

Osobni  Ostatni uZivatelé Zprostredkujici certifikaéni autority Dévéryhodné kofenové cel 4 | *

staveno pro stavitel Datum ... Popisny nazev

Informacni system...

Importovat... | || Exportovat... Odebrat Upfesnit

Zamyslené Gcely certifikatu
Cvéfeni klienta, Ovéfeni serveru

Zobrazit

Zavfit
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“# Privodce exportem certifikatu

Vita vas Privodce exportem certifikatu.

Privodce vam pomiiZe kopirovat certifikdty, seznamy divéryhodnych certifikétd a
seznamy odvolanych certifikatl z GloZisté certifikati na disk.

Certifikdt vydany certifikaéni autoritou potvrzuje vasi totoZnost a obsahuje informace
nezbytné k ochrané dat nebo k wytvofeni zabezpeéenych sitovych pFipojeni. UloZisté
certifikéti je systémovd oblast, v niZ jsou certifikaty uloZeny.

Pokraujte kliknutim na tlacitko Dalsi.

I I Zrusit

V exportu privatniho kli¢e zvolime moZnost Ano, exportovat privatni klic:

& 4# Prlvodce exportem certifikitu

Exportovat privatni kli¢
MiiZete se rozhodnout exportovat privatni kli¢ s certifikdtem.

Privétni kli€e jsou chranény heslem. Checete-li exportovat privatni kii€ s certifikdtem,
musite v pozd&jsim dialogu zadat heslo.

Chcete exportovat privatni kli€ s certifikatem?

I (@) Ano, exportovat privatni kIig I

O Ne, neexportovat privatni kiig

Zrusit

Import certifikatd a vytvoreni keystore
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Vybereme format, ve kterém chceme certifikat exportovat dle nize uvedenych variant:

4 4+ Privodce exportem certifikatu

Format souboru pro export
Certifikdty lze exportovat v riznjch formétech.

Vyberte format, ktery chcete pouZit:
Bindrni X.509, kédovéni DER (CER)

%.509, kédovani Base-64 (CER)

Zahrnout vechny certifikdty na cesté k certifikdtu, pokud je to moZné

(@) Format Personal Information Exchange - PKCS & 12 (PFX)

I [w]Zahrnout véechny certifikdty na cesté k certifikdtu, pokud je to moZné I

|| odstranit privétni kiig v piipadé Gsp&Eného exportu

Exportovat vSechny rozdifené vlastnosti

[]zapnout ochranu osobnich tidaji u certifikétu

Serializované (loZisté certifikati (55T)

Certifikdty standardu Cryptographic Message Syntax Standard - PKCS &, 7 (P7B)

| Dalsi | Zrusit

X

Nastavime heslo pro pfistup k privatnimu klici, ktery jsme obdrzeli spolu s certifikatem:

«  £# Privodce exportem certifikatu

Zabezpeéeni
V zajmu zabezpefeni je nutné privatni kli¢ chrénit pomoci hesla nebo objektd
zabezpedeni.

[ Ndzvy skupin a uZivatelskd jména (doporueno)

Pridat

Odebrat

[]Heslo:

Potvrzen( hesla:

Sifrovéni: | TripleDES-SHAL ~ ~

X

Import certifikatd a vytvoreni keystore
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Nasledné zvolime nazev souboru, do néhoz budeme chtit certifikat exportovat.

X
€ L» Privodce exportem certifikatu
Soubor pro export
Zadejte ndzev souboru, do n&jz chcete data exportovat.
Nazev souboru:
D:\certifikaty\ISUT\ISUT-test-202011\ISUT-test-20201 1ME.pfx Prochazet... |
Z[ugit
x
€ £* Privodce exportem certifikatu
Dokonéeni Privodce exportem certifikatu
Usp&né jste dokongili Privodce exportem certifikatu. P o gy
ravodce exportem certifikatu = X
Zadali jste nasledujici nastaveni:
Nazev souboru D:\certifikaty\ISUI\ISUT-test-20201
Exportovat klige Ano - . e
Zahrnout vEechny certifikdty v cesté k certifikdtu Ano EKF}G rt perEhl USPESHE-
Format souboru Formét Personal Information Exchz
oK
[ ooonct |||zt

Timto postupem ziskadme certifikat véetné certifikacnich autorit (CA).

Certifikat byl UspéSné exportovan i se vSemi soubory certifikacni autority. Nyni mame k dispozici
certifikat pro nase OVM, ktery spliiuje vSechny poZadavky a lze jej pouzit k importu do soubori
keystore a truststore.
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2.3 Vytvoreni keystore.jks

Keystore je nezbytny pro nacteni do SoapUl, protozZe se jednd o ulozisté certifikatl pro Javu.

V tomto postupu si ukdazeme vytvoreni prostfednictvim programu Portecle. Vytvofeni je mozné i

jinymi nastroji, které zde nebudou popisovany.

Spustime program Portecle, ktery je dostupny ke stazeni na adrese:
(http://sourceforge.net/projects/portecle/).

Zvolime File - New Keystore = vybereme typ JKS

&% Portecle — O

File Tools Examine Help
| (@8] @]

| Alias Name [t act podified

New Keystore Type hd

Selectthe type of the new Keystore:
® JKS |
) PKCS #12

) JCEKS

) JKS (case sensitive)
) BKS

) BKSV1

) UBER

) GKR

| OK | Cancel

Mo keystore loaded

Import certifikatd a vytvoreni keystore
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Dale zvolime Tools = Import Key Pair

5T [Untitled] - Portecle _ O >

IFile [ool5|§xamine Help

E[ (Bg Generate Key Pair... Ctrl-G }l
EL Import Trusted Certificate. . Ctrl-T
BE import Key Pair__ e | Last Modified
@ Set Keystore Password...  Cul-F
@ Change Keystore Type [
Keystore Report ctrl-R
B Options...

Import a key pair into the loaded keystore

Vybereme vytvoreny certifikdt z ME (jehoZ soucasti jsou i CA) a zvolime Import.

&} Choose Key Pair File for Import it

Look In: ||—_=| ISUHest-202011 |v| eala-

B 15Uest-202011.pix
B 15Ulest-2020111E.pi
ISUIest-202011ME.pi

File Mame: |ISUI—test—20201'1ru1E.pfx |

Files of Type: ‘Key Pair Files (*.p12;* pfc*.pem) |v|

I] Choose I‘ Cancel |
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Po vyzvani vloZime heslo k vygenerovanému certifikatu a potvrdime OK.

PECS#12 Keystore Password @ Import Key Pair £

EnterF‘aSSWDrdI| |I Select a key pair for import:

{3TEBG5CO-63TF-4C30-A084-6EA32A824081}
0K Cancel

Algorithm: RSA (1 024 bits) Cerificate Details

Po vyzvani vloZime alias k tomuto certifikatu napft. ,isui_test” a zvolime heslo (napf. aaaaaa).

. . 52 | :
Key Pair Entry Alias Key Pair Entry Password == Irnport Key Pair (=23
Enter Mew Password: |""" |
Enter Alias: fisui_test H i N Pesemmk [eosend] | @ Key Pair Import Successiul.

oK Cancel
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Zvolime File > Save Keystore As a novy keystore uloZzime do souboru keystore.jks (s heslem aaaaaa).

&1 [Untitled] - Portecle - O s
Eile Tools Examine Help
EBEEIEEEIREIEIEE)
Alias Name [ Last Modified
isui_test 172021 7:42:17 CEST |
|Keystore type: JKS, provider: SUN, size: 1 entry
Set Keystore Password EN
Enter New Passward: |u-uu |
Confirm Mew Password: |-uuu |
[o<]
L.
AT Save Keystore As *

Save In: ‘IleUI—test—EUEUT] ‘V‘

B keystore-202011jks
& truststore-202011.jks

File Mame: ISUI-test—keystoreQUQUﬁ.jks I |
Files of Type: | Java Keystore Files (= ks cacerts) |v|

I Save I| Cancel |
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2.4 Vytvoreni truststore.jks

Spustime program Portecle a zvolime File > New Keystore - vybereme typ JKS

(Q,T Portecle

(=[E@] = ]

File Tools Examine Help

| [=]a]e]

@] Alias Name odified

New Keystore Type =

@ JKS

T PROSHIZ2

1 JCEKS

() JKS (case sensitive)
O BKS

O BKS-V1

) UBER

1 BKR

IN[] keystore loaded

Zvolime Tools = Import Trusted Certificate

Postupné vloZime oba testovaci certifikaty SZR (Test RootCA.cer, Test SubCA.cer).

1 [Untitled] - Portecle

[ File |Tools| Examine Help

ﬂ ¥ Generate Key Pair... Cirl-G

[8]e

i
El Import Trusted Certificate.. coim f—— ——
Import Key Pair... Chrl-K
@ Set Keystore Password...  Cul-F
B? Change Keystore Type »
Keystore Report CHrl-R
B2 Options...

1 ST Import Trusted Certificate

= |

"

LookIn |ﬁ certifikaty

[~}

3 1SUIHest-201601
ISZR AIS CA(1).crt
ISZR AIS CAcer
ROOT CA SZR.cer
Test RootCA cer
Test SubCA. cer
Test SubCA1(1).crt

File Name: |

Files of Type: |)( 509 Certificate Files (*.cer,”.cri*.cert™ pem) | v|

Import Trusted Certificate

® Could not establish a trust path for the certficate.
The cerficate information will now be displayed after
which wvou may confirm whether or not you trust the

ceificate.

Lok |

IR

|Imp0r1 a key pair into the loaded keystore
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Po importu se zobrazi detail certifikatu.

Certificate Details for entry 'iszr_test_root’ X

I:l Certificate 1 of 1 I:l

Version: 3
Subject CN=Informacni system zakladnich registru RootCA
lssuer. CH=Informacni system zakladnich registru RootCA
Serial Number.  4A22 5115 CF5B 22A8 47A4 1690 DCAS 2730
Valid From: |30.9.2011 10:49:31 CEST
Valid Until:  30.9.2031 10:59:30 CEST
Public Key: RSA (2 048 bits)
Signature Algorithm:  SHAZG6withRSA
SHA-1 Fingerprint.  1D:DC:2C:D0:86:9E:18:AF92:FB:ED:82:52:08:46:B9:98:96:BB.EB

MD5 Fingerprint.  24:CF.3B:2D:1A483:2F.91.52.1579:8B:D58:BE:99:4A

| Extensions || BEM Encoding
Import Trusted Certificate 2
? Do you wantto accept the cerificate as trusted?
Yes | Mo

Zadame pfislusny alias pro oba testovaci certifikaty ISZR, napf. ,iszr_test_root”,
,iszr_test sub_root”.

i '

Trusted Certificate Entry Alias 2

Import Trusted Certificate =

Enter Alias:||iszr_te st_root |

@ Trusted Cerificate Import Successful.

|| 8] || Cancel
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Nasledné ziskame dva certifikaty:

&1 [Untitled] - Portecle

File Tools Examine Help
[a]=/ojgas[es|[=]8]e]
[ @] Atias Name

iszr_test_root
iszr_test_sub_root

| Last Modified
17.2021749:16 CEST
17.2021749:55 CEST

|Keysmre type: JKS, provider: SUM, size: 2 entries

Keystore uloZime do souboru: File > Save Keystore, nastavime heslo (napf. aaaaaa) a uloZzime do
souboru ,truststore.jks”.

i save Keystore As *

Save In: ‘lj Certifikaty ‘V| E

9 __MACOSX

File Name: ||truststore—ISUI_test202011.jks I |
Files of Type: |Java Keystore Files (* jks;cacerts) |V|

II Save I ‘ Cancel ‘

Zda se vytvoreni povedlo, zjistite pri UspéSném spusténi projektu v SoapUl. Zprovoznéni SoapUl pro
Ucely testovani je uvedeno v samostatném dokumentu Testovani v SoapUl.
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